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1 Introduction 

The ATG Business Control Center is a browser-based interface that you use to create and edit many of the 
elements required to set up and maintain ATG-based Web sites. The activities you can perform in the ATG 
Business Control Center are divided into two general areas: 

 ATG Content Administration activities. The ATG Business Control Center is the primary 
interface for performing ATG Content Administration tasks, including the creation and 
deployment of Web site content. 

 ATG Personalization activities. You use the ATG Business Control Center to create and 
manage the components that are responsible for delivering personalized Web site 
content (content that changes dynamically for each site visitor). These components 
include user profiles, organizations, roles, user segments, content targeters, and 
content groups. 

The ATG Business Control Center is also used as the starting point for launching several ATG applications, 
including the following: 

 ATG Merchandising 

 Search Administration 

 The Site Administration utility 

 ATG Outreach 

 ATG Campaign Optimizer 

 ATG Service applications 

Note: Scenarios, slots, and workflows are not managed through the ATG Business Control Center. To 
create and edit these items, use the ATG Control Center. See the ATG Personalization Guide for Business 
Users for more information. 

About This Manual 
This manual has two goals: 

 To introduce the ATG Business Control Center interface and describe how to perform 
tasks that are common to any application that uses this interface. These tasks include 
navigating the UI, performing batch edits, and using elements such as the Search tab. 
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 To describe how to use the ATG Business Control Center to create and manage user 

segments, content targeters, and content groups, which are the ATG Personalization 
features you use to set up a Web site that displays dynamic content. 

The following topics are covered elsewhere in the ATG documentation set: 

 

Topic Refer to… 

Managing user profiles, organizations, and roles ATG Business Control Center Administration 
and Development Guide 

Completing ATG Content Administration tasks—for 
example, creating projects and managing the 
deployment of Web site assets 

ATG Content Administration Guide for 
Business Users 

Using the ATG Business Control Center to perform 
ATG application-specific activities 

The documentation set for each ATG 
application  

 

Installing and Starting the ATG Business Control Center 
The ATG Business Control Center is installed automatically as part of the ATG platform if your installation 
also includes ATG Content Administration. For information, refer to the ATG Installation and Configuration 
Guide. 

Configuring the Database 

A SOLID demo database is provided for evaluation purposes. If you are using this database, you do not 
need to perform any database configuration in order to use the ATG Business Control Center. However, if 
you are using a database other than SOLID, you must perform several configuration steps to set up your 
database for use with ATG products. 

The steps are described in Configuring the ATG Content Administration Database in the ATG Content 
Administration Programming Guide. Note in particular that you must run the importDPSUI script to 
import view mapping data used for the Personalization interface. 

Login Requirements 

To log into the ATG Business Control Center and access specific areas within it, you need the following 
user configuration: 

 An internal user profile, defined in the Internal Users interface of the ATG Business 
Control Center. When you log into the application (see below), you are prompted to 
enter a user name and password. The values to enter are the login name and password 
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specified in your user profile. A default profile is provided – see Starting the ATG 
Business Control Center. 

 An ATG Portal role, for example 100001-member. This role is required for access to the 
ATG Business Control Center framework. ATG Portal roles are assigned through the 
Internal Users interface. In this case, the appropriate roles are located by default in the 
Global Roles > Root Folder > Bizui directory. If you have only this role, you 
have access to the Users options in the ATG Business Control Center, but to none of 
the other options (see BCC Home Page). 

 An ATG Content Administration role, for example EPub-User or EPub-Manager. 
These are also added to your user profile through the Internal Users interface in the 
ATG Business Control Center. Although you do not need one of these roles to start the 
ATG Business Control Center, you do need one to access all ATG Content 
Administration features, which include projects. Because the targeting features you 
work with in the ATG Business Control Center use projects, you need this role to be 
able to work with them. If you do not have this role, the Targeting and Segmentation 
option on the Home page does not appear. 

 Some ATG applications use ATG Customer Intelligence to provide a set of reports. For 
example, ATG Outreach includes reports that business managers can use to view data 
about e-mail campaigns. If you want to view any reports, you need one of the 
reporting roles that allows access to the Report Center, for example Report Viewer 
or Reporting Administrator. These roles are located in the Global Roles > 
Root Folder directory. 

 A Web browser. The ATG Business Control Center supports various browsers and 
operating systems. For up-to-date information, see the Supported Environments page 
on atg.com: http://www.atg.com/en/products-
services/commerce/supported-environments/ 

If you use Internet Explorer 8 for viewing the ATG Business Control Center, note that 
you must enable the Tools > Compatibility View option in the browser to ensure 
correct behavior. For more information, refer to Internet Explorer 8 and ATG Applications 
in the ATG Multiple Application Integration Guide. 

Starting the ATG Business Control Center 

To start the ATG Business Control Center: 

1. Make sure the appropriate database is running. If you are evaluating ATG products on 
a local machine running Windows, you can start the SOLID database installed with 
ATG 10.0.2 by selecting Start > Programs > ATG 10.0.2 > ATG Content Administration > 
Start SOLID Server. 

2. Start the ATG products that you want to use with the ATG Business Control Center. For 
example, start ATG Content Administration or an ATG application such as ATG 
Merchandising. In all cases the ATG Business Control Center will be started 
automatically as part of this process. For detailed information, refer to the 
documentation for the appropriate ATG product. 

For evaluation purposes on a local Windows machine, you can start ATG Content 
Administration as follows: select Start > Programs > ATG 10.0.2 > ATG Content 
Administration > Start ATG 10.0.2. 
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3. Point your Web browser to the server where the ATG Business Control Center is 

running. The URL takes the following form: 

http://hostname:port/atg/bcc 

where hostname is the name of the server, and port is the number of the port which 
that server uses for the ATG Business Control Center. 

http://anycorp.androcles:8080/atg/bcc 

If you are running the ATG Business Control Center on a local machine, enter the 
following URL: 

http://localhost:port/atg/bcc 

The default port numbers for JBoss, IBM WebSphere, and Oracle WebLogic are 8080, 
9080, and 7001, respectively. See the ATG Installation and Configuration Guide for 
details. 

4. When the ATG Business Control Center login dialog box appears, enter the login name 
and password defined in your ATG user profile. The fields are case sensitive. For 
evaluation purposes, or to set up profiles for other users, use the following login name 
and password: 

admin 

admin 

Note for Internet Explorer 8 Users 

If you use Internet Explorer 8 for viewing the ATG Business Control Center, enable the Tools > 
Compatibility View option in the browser. For more information, refer to Internet Explorer 8 and ATG 
Applications in the ATG Multiple Application Integration Guide. 

ACC Support 
The Web-based ATG Business Control Center is intended to supersede the ACC interface used in earlier 
versions of the ATG platform. The ACC remains available in ATG 10.0.2. You can use it to edit the ATG 
Personalization components that are described in this guide, with the following constraints: 

 Content targeters and content groups that you created in the ACC can be opened and 
edited in the ATG Business Control Center. However, once you edit these items in the 
ATG Business Control Center, you cannot subsequently edit them in the ACC. 

 Content targeters and content groups can be configured to support a multisite 
environment (one in which a single instance of ATG products is used to run more than 
one Web site). However, the multisite features for these items are not available in the 
ACC. To support multiple sites, manage these items through the ATG Business Control 
Center. 
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 User profiles, organizations, and roles can be created and edited in either the ATG 

Business Control Center or the ACC. The ATG Business Control Center is the 
recommended interface. 

 The ATG Business Control Center requires ATG Content Administration. If your ATG 
product suite does not include ATG Content Administration, you must continue to use 
the ACC to create and edit the components described in this guide. See the ATG 
Personalization Guide for Business Users. 

 Slots, scenarios, and workflows must be created and edited in the ACC. 
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2 ATG Business Control Center User 

Interface 

This chapter introduces the ATG Business Control Center user interface. It describes basic navigation and 
shows how to work with elements of the UI that are common to any application that uses the ATG 
Business Control Center framework. 

BCC Home Page 
After you log in to the ATG Business Control Center, the BCC Home page appears, as shown in the 
following image: 

 

The elements that make up the BCC Home page are described below. 
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 The Welcome bar at the top shows the name of the logged-in user (the values of the 

first name and last name properties in the user profile). 

 The Utilities menu contains a link to the ATG product documentation. If your 
installation includes ATG Customer Intelligence, the menu also contains a link to the 
Reporting Center. 

 The BCC Home link returns you to this page from other parts of the ATG Business 
Control Center. 

 The Log Out link ends your ATG Business Control Center session. 

 The To Do List shows the ATG Content Administration projects that have been 
created in your system. For comprehensive information on using projects, refer to the 
ATG Content Administration Guide for Business Users. 

 The Operations list contains the options you use to enter the editing interfaces for the 
ATG applications available to you. The options vary according to the following: 

 The options that your role has permission to use. 

 The ATG modules and applications that are running on the server. 

Project Basics 
Many of the items you create within the ATG Business Control Center, such as segments, targeters, and 
content groups, as well as assets such as product images, price lists, and SKUs from applications like ATG 
Merchandising, must be published to your live sites along with any other items necessary for running the 
sites. These necessary items include individual pieces of content, images, style sheets, and the Web pages 
themselves. The process of publishing assets from a development environment to a live site is managed 
by ATG Content Administration. The following are some key ATG Content Administration terms that you 
need to be familiar with when you create and edit items in the ATG Business Control Center: 

 Project: ATG Content Administration controls the lifecycle of items that are published 
to your Web sites through an entity called a project. A project contains a set of tasks 
that define the stages of the creation and publishing lifecycle. Typically, tasks include 
authoring, approval, and deployment. Tasks can be completed by different users. For 
example, the approval task could be completed by a supervisor, and the deployment 
task could be performed by a Web site administrator. 

Often, a project represents a logical grouping of items related to a particular business 
goal. For example, you could have a project called “New home page” that contains all 
the items you need to create a home page on a site. Another example might be a 
project called “Executive bios” that you use to deploy updated versions of executive 
biographies to your corporate information pages. Any number of items can be 
managed and deployed by a single project. 

 Asset: In ATG Content Administration, any item that you create, edit, and deploy is 
referred to as an asset. Different ATG applications have their own types of assets. For 
example, ATG Merchandising assets include products, SKUs, and price lists. ATG 
Personalization assets include user segments, targeters, and content groups. In several 
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places in the ATG Business Control Center interface, “asset” is used as a generic term 
for these items. 

 Versioning: As well as managing the creation and deployment of assets, ATG Content 
Administration performs a type of source control, called versioning, on each asset. 
When you create an asset, the system gives it the number 1. When you or another user 
edits the asset, a second version is created, and versions 1 and 2 are both stored in the 
system. This behavior has two purposes: it prevents conflicts when two or more 
people edit the same asset, and it allows you to recover from errors by reverting to a 
previous version of an asset at any time. 

For detailed information on any of these terms, or for more information about versioning and 
deployment, refer to the ATG Content Administration Guide for Business Users and the ATG Content 
Administration Programming Guide. 

Creating a Project 

As described for targeting assets in later chapters of this guide, the first step when you create an asset is 
to specify the project that will manage the creation, versioning, and deployment of the item. The 
following image shows the fields you use to create a project. This dialog box appears after you select the 
Targeting and Segmentation option on the BCC Home page. 

 

To complete this screen, follow the steps below: 

1. Enter a name and description for the project. The name is used to identify the project 
in various places in the UI, for example in the To Do list on the Home page. Making this 
name distinctive is recommended so that you and other users can distinguish it from 
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other projects in your system. Project names do not have to be unique, however. The 
description is optional but can be helpful where many projects have similar names. 

2. Click Continue when you have finished. 

At this point, the project’s Author task becomes active, and you can start creating assets. For targeting 
items, the creation process is described in detail in later chapters of this guide: 

 User Segments 

 Content Groups 

 Content Targeters 

For other types of assets, refer to the documentation for the ATG application that manages them. For 
more detail on projects, refer to the ATG Content Administration Guide for Business Users. 

Adding Assets to a Project 

Most assets that you create or edit in the ATG Business Control Center must be added to a project so that 
they can be versioned and deployed. To see the assets that have been added to the current project, 
display the Project tab, as shown below: 

 

When you create an asset, for example a user segment, the asset is automatically added to the current 
project, and the label “NEW!” appears next to the asset in the Project tab. The new asset also appears in 
the Browse tab for this project. The asset will be published to the live Web site when the project is 
deployed. The asset is also added to the versioning system. 

Adding or Changing Existing Assets 

You can also add an existing asset to a project. To do so, locate the asset in the Browse tab, check the box 
to select it, and then click the Add to Project icon. The asset appears in the Project tab and will be 
published to the live site when the project is deployed. 
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You can make changes to an existing asset if necessary. To do so, highlight the asset in the Browse tab so 
that its details appear in the General and Rules tabs on the right. Make any changes you need, and click 
Save. The asset is automatically added to the project, and a new version of the asset will be added to the 
versioning system when the project is deployed. 

Note: When you create an asset as part of a project, the asset will not appear in the Browse tab for other 
projects until the asset is checked in to the versioning system. Check-in typically occurs when the project 
is deployed (the Deploy task is completed). For more information, see the ATG Content Administration 
Guide for Business Users. 

Removing Assets from a Project 

To remove an asset from a project, display the Project tab, select the asset to remove, and click the Revert 
Changes and Remove from Project icon shown in the previous image. To select all assets for removal, click 
the checkbox in the icon bar. 

When you remove an asset marked as new, the asset is simply deleted from the system. When you 
remove an asset that you changed as part of this project, the changes are discarded and the asset is 
removed from the project. The previous versions of the asset still exist in the system. 

For more information on how to delete existing assets from the system, refer to the ATG Content 
Administration Guide for Business Users. 

Completing the Creation Process and Deploying the Assets 

When you have finished creating the assets for a project, you must indicate that the Author task is 
complete so the next stage, usually a Content Review task, can start. Deployment is the last task in any 
project; the assets can be deployed to the live site only when all other tasks have been completed. 

The default project used for targeting items contains the following tasks: 

 Author 

 Content Review 

 Approve for Production Deployment 

 Wait for Production Deployment Completion 

 Verify Production Deployment 

 Wait for Production Revert Deployment Completion 

Note: If your ATG environment uses a staging site as well as a production site, the display includes a 
similar set of tasks for deploying to staging. For more information, refer to the ATG Content Administration 
Programming Guide. 

To indicate that the Author task is complete, select Ready for Review from the Task menu, as shown. 
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The Content Review task is now active. At this point, you move out of the targeting interface and into the 
project interface, which is part of ATG Content Administration: 

 

When the assets in the project have been reviewed by you or another user, indicate that the Content 
Review task is complete by selecting Approve Content from the Select Action menu, as shown below. 
Then click Go. 

 

When the Approve Content task is complete, the Actions field appears for the next task, the Approve for 
Production Deployment task. 

The deployment tasks are described in detail in the ATG Content Administration Programming Guide. The 
basic steps you perform to complete them are summarized below: 
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1. Select Approve and Deploy to Production to complete the Approve for Production 

Deployment task. 

2. Monitor the display until the Verify Production Deployment task becomes active (the 
Actions field appears). You may need to refresh the page to see these fields. 

3. When the deployment has finished, the Verify Production Deployment task becomes 
active; select Accept Production Deployment from the Actions list and click Go. 

Opening an Existing Project 

You do not have to complete the Author task in one session. As long as the Author task has not yet been 
marked as complete, you can return to the project at any time and add or create assets. 

To locate and open an existing project: 

1. Display the BCC Home page. 

2. In the To Do list, select the appropriate Show option, for example All Projects and 
Tasks. These options are described in detail in the ATG Content Administration Guide for 
Business Users. 

3. Expand the entry for that project. The name of the current task appears, as shown in 
the image below, where the Author task appears for the Vacation list 
(segments) project. 

 

The task name (Author, in the example) is a link you can click to open the project. Note 
that the task must either be assigned to you or marked as unassigned for the link to be 
active. For more information on assigning tasks, see the ATG Content Administration 
Guide for Business Users. 

4. Click the task name. When the targeting UI appears, select the appropriate option 
from the Show menu. For example, if you want to edit a content group that you 
previously created as part of this project, select Content Groups from the Show menu. 

Notes: 
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 If the project has moved beyond the Author task to the Approve Content task, the 

assets can no longer be edited. To reactivate the Author task and allow asset editing, 
select Reject from the Select Action menu for the Approve Content task and click Go. 

 

 If any of the deployment tasks are active (for example, Approve for Production 
Deployment), the assets cannot be edited. To reactivate the Author task in this case, 
select the corresponding Revert option from the Select Action menu and continue to 
select this option for each task until the Author task is active again. 

 To delete a project, select Delete Project from the Actions menu for the Author or 
Content Review tasks. When you delete a project, the assets that were created for this 
project are not added to the versioning system, and any changes you made to existing 
assets through this project are not preserved in the system as new versions. For more 
information, see the ATG Content Administration Guide for Business Users. 

Using the Search Tab 
Use the Search tab to find and display specific items in the users, organizations, and roles interfaces. For 
example, to find all user profiles whose Receive Email property is currently set to Yes, you would do the 
following: 

1. Click BCC Home. 

2. Under Personalization , click External Users. 

3. Display the Search tab. 

4. Make sure the asset type is set to User (or a profile sub-type, if appropriate). 

5. Enter the values shown in the image below, and then click Search. 
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The display changes to show the profiles that meet the criteria. You can view and edit the profiles just as 
you would through the Browse tab. 

For more information on specifying criteria in the Search tab, see Using the Asset Picker to Select Items. 

Note: For information on creating or editing profiles, organizations, and roles, refer to the ATG Business 
Control Center Administration and Development Guide. 

Using the Multi Edit Tab 
The Multi Edit tab gives you several ways to edit a large number of items more easily. For example, an 
administrator who wanted to change the Receive Email property to No in all the profiles in the system 
could use the Multi Edit tab, which would allow him or her to change the property once and apply the 
change to all profiles. You could also use the Multi Edit tab in combination with the Search tab to perform 
a batch edit on a specific group of assets. As well as batch editing features, the Multi Edit tab provides 
different ways to display assets for editing that reduce the number of mouse clicks needed to make the 
edits (see the descriptions of the Step Edit and List Edit icons below). 

To use the Multi Edit tab, complete the following steps. Note that the procedure uses profiles as an 
example, but it applies to any assets for which the Multi Edit feature is available. 

1. In the Browse or Search tabs, locate and select the profiles that you want to edit. Select 
them by checking the box next to the profile. To select or unselect all profiles, use the 
checkbox at the top, as shown: 
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2. Click the Add to Multi Edit icon. The title of the Multi Edit tab changes to show the 
number of profiles you added. 

3. Display the Multi Edit tab. 
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Controls in the Multi Edit tab are described below. 

 The Filter By menu lets you show only assets of the specified type. 

 The icons above the list of profiles allow you to do the following: 

 The Step Edit icon lets you edit profiles by navigating through them with Next 
and Previous buttons. Although you edit the profiles individually, using this 
feature is faster than making the same edits through the Browse tab because 
you use fewer mouse clicks to access the properties you want to change. 

 The List Edit icon displays all the profiles in the editing pane on the right, which 
allows you to scroll through them and edit them without having to select them 
first in the list on the left. Like Step Edit, this option lets you edit multiple 
profiles more quickly by requiring fewer mouse clicks. 

 The Apply to All icon lets you perform batch edits of one or more properties. 
The edits apply to all the profiles selected in the Multi Edit tab. See Performing 
Batch Edits. 

 The Remove icon lets you remove the selected profiles from the Multi Edit tab. 
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In all cases, you use the checkboxes to select the profiles to which you want the icon 
action to apply. Use the checkbox above the list of profiles to select or unselect all 
checked profiles. 

Performing Batch Edits 

The procedure described here allows you to edit one or more asset properties and have those edits apply 
to a group of assets. For example, an administrator could use it to change the Receive Email property to 
No in all the profiles in the system. 

1. Add the assets you want to change to the Multi Edit tab. 

2. Select the assets to which you want the changes to apply. (This step exists to make 
editing easier in cases where you are performing many batch edits, some of which you 
may not want to apply to all assets that you added to the tab.) To select all the assets 
in the tab, use the checkbox in the icon bar. 

3. Click the Apply to All icon and select the group of properties that contains the 
properties you want to edit. 

 

Note: If no property groups have been defined for your system, the message “No 
property groups exist for this type…” appears. For information on how to set up 
property groups, refer to the ATG Business Control Center Administration and 
Development Guide. 

4. Locate and edit the properties you want to change. 
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5. Edit the appropriate properties by clicking the Keep Existing Value field and selecting 
the new value. 

6. Click Apply to All. The display changes to show the number of assets that were 
affected. 

 The Successful list shows any assets that were changed. A green checkmark also 
appears next to these assets in the left pane. 

 The Unsuccessful list shows assets that were not changed because one or more 
errors were encountered during the edit. 

 The No Change Needed list shows assets that were not changed because the 
property you edited was already set to the new value. 

 The Not Changed list shows assets that were not changed because the edit was 
interrupted when you initiated another task in the ATG Business Control Center. 

The left pane displays a red X next to assets in the Unsuccessful, No Changed 
Needed, or Not Changed. 

To view an asset’s current property values, click its name in one of the Details pane 
status boxes. Information about why an asset was not changed also appears for assets 
from the Unsuccessful box. 
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7. Click Exit. The editing panel disappears. 

You do not need to remove the assets from the Multi Edit tab before continuing with 
other activities in the ATG Business Control Center. Be aware, however, that the assets 
will remain added to Multi Edit until you start a new activity through the BCC Home 
page or log out. To remove assets from the tab, select them and click the Remove icon. 

Editing Asset Properties 
The way you enter values depends on the type of property you are working with. Some of the more 
complex property controls, such as controls for properties that can contain more than one value, are 
described below. 

 Some properties contain Select and Create buttons, as shown: 

 

These buttons appear for properties whose value is another repository item type with 
its own properties. For example, a Home Address property could be linked to a 
repository item type called Contact Info, with address, state, and zip code properties. 
Use the Create button to create a new item of the required type (for example, a 
Contact Info item). Use the Select button to select an existing item. 

 

You can edit an existing entry by clicking the property value, which appears in blue, as 
shown in the image above. Bear in mind, however, that editing the properties here 
changes the item in the underlying repository, which means the change applies 
wherever this item is used (for example, in other user profiles). 

To remove an existing entry, click the Clear icon. 

Note: If the properties of the linked-to repository item are empty, the repository item’s 
ID is displayed as the value, as shown below. 

 

 Some properties can contain multiple values: 
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Use the Add New button to create a new item and add it to the list. The item is added 
to the system and can be used elsewhere. Use the Add Existing button to add an item 
you or another user already created. 

To remove an item from the list, click the Remove Item icon for that item. Removing 
the item here does not remove it from your system. 

 Required properties have an asterisk next to their names. You cannot save a new asset 
if any required properties have not been specified. 

Using the Asset Picker to Select Items 
During the process of creating and editing targeting assets, you sometimes need to use the asset picker, 
which is a dialog box that allows you to locate and select one or more items for inclusion in the current 
activity. For example, when you are creating the rules that define a content group, and you want to use 
the Items in Folder option to include items from a specific folder, you use the asset picker to select 
the folder. 

To display the asset picker, click the field where you want the specified item to appear, as shown below: 

 

The appearance of the asset picker varies depending on the type of item you are working with, but the 
basic procedures for using it are the same. See the next sections, Asset Picker: Browse Tab and Asset 
Picker: Search Tab. 
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Asset Picker: Browse Tab 

Some item types are configured so that you can use a Browse tab to locate them. The items are displayed 
in a hierarchy of folders. The following image shows the Browse tab. In this case, the items are roles (this 
tab would appear, for example, if you added a People with Roles rule to a user segment). 

 

Expand the folders until the items you need are displayed. Use the checkboxes that appear next to the 
items to select them, and click OK. 

Asset Picker: Search Tab 

If the asset picker contains a Search tab, you can locate items by specifying search criteria. A list is 
displayed that contains all the items that match the query. 

To find all assets of the type you want, choose All: 
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You can narrow the search by querying specific properties. The menu choices depend on the asset type—
in this case, Whose or Whose Name or ID Contains: 

 

The following example shows the query for all roles whose Name property contains the string Buyer: 
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You can narrow the search criteria further by clicking Add Criteria and providing more information about 
the desired role. If you create multiple criteria, specify the query operator Match All (AND) or Match Any 
(OR) as necessary: 

 

To remove a set of criteria, click the corresponding Remove  icon. 
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Previewing Project Assets 

Your ATG Business Control Center environment can be set up to preview project assets so you can 
evaluate how they will appear on a live Web site. In order to preview assets, the ATG Business Control 
Center server—and, optionally, other servers—must be configured and assembled as described in the 
Setting Up Preview chapter of the ATG Business Control Center Administration and Development Guide. 

Assets can be previewed from any project that you create via the Asset Manager or Content 
Administration. Preview can be set up to provide a highly flexible matrix of preview applications and user 
profiles: you can test project assets on one or more applications that are deployed on preview-enabled 
servers, and evaluate each one from the perspective of different user profiles. 

Note: A preview session shows only changes for assets in the project where the preview session was 
launched. All other assets show the state they were in when last checked in. 

Supported Asset Types 

You can preview the following asset types: 

 GSARepository assets, for example product catalog and price list assets. 

 Personalization assets: user segments, targeters, content groups, slots, and scenarios. 

Previewing Assets 

To preview assets, complete the following steps: 

1. Add the assets you wish to preview to a project. 

2. Modify asset properties and save your changes. 

3. From the Details pane or asset properties window, click Preview As. 

Preview As opens the Preview Launcher dialog, where you select a user profile and 
preview URL, or landing page. If your ATG installation is set up to support more than 
one Web site, you also select the site you want to use for the preview: 
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Refer to the ATG Multisite Administration Guide for more information on configuring an 
ATG installation to support multiple Web sites. 

4. Click Launch to open a browser window and start a preview session that uses the 
selected landing page, site, and profile. 

After you launch a preview session from an asset, its properties window displays Preview and Preview As 
buttons: 

 Preview uses the user profile and landing page settings from the last preview session 
launched from that asset to start a new preview session. 

 Preview As opens the Preview Launch dialog, where you can change preview settings 
before launching a new preview session. 

Launching Multiple Preview Sessions 

You can launch multiple preview sessions for any asset in a project. Doing so can help you evaluate 
different combinations of launch sites and preview profiles. For example, you can launch multiple 
sessions that test a scenario on the same site with different user profiles; or evaluate how the same 
scenario operates on different sites. You can also modify the same assets in different projects and launch 
preview sessions from each project in order to compare the changes. 

Changing Preview Users in a Preview Session 

In each preview session, the browser displays the following controls: 
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 As User is a drop down menu of preview profiles. Use this menu to change the user 

profile. Then click Preview Landing Page to refresh the page with the new profile. 

Changing user profiles during a given session has no effect on the settings that are 
used when you launch a new session. 

 Preview Landing Page refreshes the browser window with the original preview URL. 

 Remove Frame removes the frame from the pages in the current session. 

Launching a Preview Session Outside the ATG Business Control Center 

Users can preview project asset changes outside the framework of the ATG Business Control Center. For 
example, you might want employees or outside reviewers who lack ATG Business Control Center login 
privileges to evaluate changes to a Web application while it undergoes development. If your environment 
has non-BCC servers that are enabled for preview, you can provide URLs to the launch pages on these 
servers to reviewers. They can invoke these URLs from any browser window. 

Note: Users who are not logged into the ATG Business Control Center can invoke preview sessions only 
with URLs to a server where the ATG Business Control Center is not running. In order to avoid security 
breaches, URLs to preview sessions on the ATG Business Control Center server are blocked. 
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3 Targeting Concepts 

The targeting items enable you to display dynamic, personalized content to Web site visitors. A targeter 
defines product items to display to site visitors who meet the targeter’s criteria. The targeter also specifies 
the times and conditions under which to issue the display. 

The three types of targeting items work together: 

 User segments are groups of users who have similar interests or requirements that 
make them good candidates for targeted content. For example, certain items may 
appeal to “people whose interests include hiking” or “people who live in New York.” 

 Content groups are items that share some characteristics that may be of interest to a 
group of users. For example, you could set up a content group that contains products 
that are related to hiking, and then configure a targeter that displays the products, in 
rotation, to the appropriate user segment. 

 Targeters are the business rules that specify what content to show, what visitors to 
show the content to, and under what conditions to show it. For example, “Show article 
X to people who live in New York on every Monday of the month.” 

When an environment has one or more registered sites, the user interface displays extensions to the rule 
configuration for these targeting items. The additional configuration makes these items site-aware. See 
Multisite Targeting Rules. 

Because targeting items are referenced by the pages on your Web site, they must be accessible to those 
pages. All user segments, targeters, or content groups that you create must be published to your live 
sites, along with the other items that are necessary, such as individual content items, images, style sheets, 
and the Web pages themselves. ATG Content Administration manages the process of publishing assets 
such as targeting items from a development environment to the live site. 

How Targeters Work with Site Displays 
Two mechanisms exist to display content on a site page: 

 A targeter defines product items for display to site visitors who meet the targeter’s 
criteria. The targeter also specifies the times and under what conditions to display the 
results. A page developer incorporates the content display on the site page. 

 A slot is defined for the site page. When an active slot is empty, the slot triggers an 
event. A scenario traps the event. The scenario defines content and displays it in the 
slot, or the scenario uses a targeter to define the content. 
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In a multisite environment, the multisite rules are evaluated when the site visitor requests a page that 
involves a targeter. See Multisite Targeting Rules. 

Targeting Interface 
You use the targeting interface to create and edit user segments, content groups, and targeters. The 
chapters that follow this one give specific procedures for working with each type of item. This section 
provides an overview of the interface and describes its main elements. 

The following image shows the panels and other items that make up the targeting interface. 

 

 The Project label shows the name of the project being used to manage the creation or 
editing process. In this case, the project is called NewSegments. See Project Basics for 
more information. 

 The Task menu, which displays the current task name (Author, in this case), contains 
the actions you can perform as part of the current task. When you have finished 
creating or editing all the items in the project, you use this menu to activate the next 
task in the project, typically Content Review. 

 The Browse tab displays a list of all existing items of the type indicated by the Show 
menu. In the illustration, five user segments represent all the segments that currently 
exist in the system. 
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Note: The items in the Browse tab are not necessarily in the current project. However, 
any item you create is automatically added to the project. 

 The Project tab shows all items that have been added to the current project. These are 
the items that will be deployed to the live site when the project is complete. 

 The icons in the Browse tab allow you to do the following: 

 Create a New item of the type that appears in the Show menu. 

 Duplicate the selected item(s). This action gives you a quick way to create 
several similar items. You create one, and then duplicate it as many times as 
needed, making appropriate changes to the duplicates. For items that have 
many complex rules, this technique can save time. 

 Move the selected item(s) to a different parent folder. 

 Add the selected item(s) to the current project (see Project Basics). 

 Delete the selected item(s). 

 

In all cases except Create New, you use the checkboxes in the Browse list to select the 
item or items to which you want the icon action to apply. Use the checkbox next to the 
icon bar to select or unselect all items. 

 The name of the current item, in this case a segment called Campers.properties, 
appears at the top of the right pane. 

 The General tab contains fields where you enter basic setup information for this item, 
such as a name and some descriptive text. The item whose information displays here is 
the one selected in the Browse tab—the Campers segment, in this example. 

 The Rules tab allows you to enter the detailed information that defines this item; for 
example, the rules that make up the inclusion or exclusion criteria for a user segment. 
The Rules tab is described in detail later in this guide. 

 The Save and Revert buttons allow you to preserve or undo any changes you make to 
this item. 

Note: When you start creating an item, a Create button appears instead of Save. 

 To return to the BCC Home page, select BCC Home from the dropdown menu above 
the Browse and Project tabs. 
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Viewing Targeting Items 

To view the user segments, content groups, or targeters in your system, complete the following steps: 

1. From the BCC Home page, select Personalization > (Targeting and Segmentation) 
Browse. 

 

2. From the Show menu, select the type of targeting item you want to view: 

 

3. All items of the selected type appear in the Browse list on the left, if they meet the 
following criteria: The item was added to a project and was checked in to the 
versioning system, which typically occurs when the project’s Deploy task is marked as 
complete. For more information, refer to the section, Project Basics. See also the ATG 
Content Administration Guide for Business Users. 

When you select an item in the left pane, the right pane shows the details for the item. 

Working with Folders 
Targeting items are managed in the ATG Content Administration system as file assets with .properties 
extensions. By default, the items are stored in the following location: 

<ATG10dir>\home\Publishing\versionFileStore\PublishingFiles 

where <ATG10dir> refers to the ATG 10.0.2 installation directory; for example, C:\ATG\ATG10.0.2. 

Within the ATG Business Control Center, assets are tracked through a path in the ATG registry, which is an 
internal directory structure that allows ATG modules to access items created within other modules. By 
default, targeting items have the following path in the registry: 
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 User segments and content groups: /atg/registry/RepositoryGroups 

 Targeters: /atg/registry/RepositoryTargeters 

The last part of the path, RepositoryGroups or RepositoryTargeters, is a folder in the registry. In 
some cases you may want to use a different folder. The next section includes instructions to specify a 
different folder. 

Specifying the Parent Folder when You Create an Item 

When you create an item, you can specify a parent folder. You can change that selection up to the time 
you click Create. 

To select a parent during item creation: 

1. Click Select Parent at the top right of the new item details pane in the targeting 
interface. 

2. In the asset picker, click the button next to your choice, then click OK. Note that the 
root directory, which does not appear in the left pane display, appears on the asset 
picker list. You can choose any folder that exists below the root (RepositoryGroups 
or RepositoryTargeters). 

The name of the folder you select appears above the Select Parent button. 

3. If this is the last action in the creation process, click Create. Otherwise, finish the 
configuration and then click Create. 

Moving an Item to a New Parent Folder 

After a targeting item has been created, the Select Parent button is no longer available. To change the 
location of an item in this situation, use the Move feature. 

To move a targeting item: 

1. In the Browse pane, check the checkbox of the item you want to move. 

2. Click the Move icon (arrow) and select Move. 

3. In the asset picker, check the radio button next to the intended destination folder, and 
Click OK. Note that the root directory, which does not appear in the left pane display, 
appears on the asset picker list. You can choose any folder that exists below the root 
(RepositoryGroups or RepositoryTargeters). 

The left pane shows the item in its new location in the tree. 

Creating a Folder 

To create a folder for a targeting item: 

1. From the BCC home page, do one of the following: 

 From the To Do list, choose a Manage Commerce Assets project, and click 
Author. 
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 Create a project: In the browse pane, open Merchandising and click Manage 

Commerce Assets. Supply a Project Name and, optionally, a Project Description. 

2. Select Targeting and Segmentation from the application switcher dropdown list at 
the top of the left pane. 

3. Select an item type from the Show list. 

4. Click the Create New icon. 

5. Select Folder. 

 

6. Specify a name for the new folder. 

7. Click Create. 

The new folder appears in the Browse list (you may have to refresh the page to see it). 
It is also added to the project as an asset and will be deployed to the live sites when 
the project is complete. 

Deleting Segment or Content Group Folders 

Segments and content groups share folders. Any folder you create in the segment or the content group 
interface is added to the path atg\registry\RepositoryGroups and can store assets of either type. 
However, in the segment interface, content groups are hidden, and in the content group interface, 
segments are hidden. For this reason, if you attempt to delete what appears to be an empty folder in 
either interface, you may see the following error message: 

Error: Cannot delete the folder because it has contents which may not be displayed 

in the current view. 

The error occurs because the folder you are trying to delete contains items that are hidden because they 
are not the type of asset you are editing. 

The same error can appear if other types of filtering are occurring. For example, if you are working in a 
project that references the external user profile repository, assets that apply to internal users are hidden. 
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Multisite Targeting Rules 

In a multisite environment, the user interface displays extensions to the rule configurations for the 
targeting items: user segments, content groups, and targeters. You can use the rule extensions to make 
these items site-aware. 

The following table shows the possibilities for each item type: 

 

Targeting Item Multisite Rule Features 

User segment Specify the site on which a rule executes. 

Content group Specify the site on which a rule executes. Specify the site on which to search for 
content. 

Targeter Specify the site on which a rule executes. Specify the site on which to search for 
content. 

 

The multisite configuration extensions appear only in the rules. The remaining configuration options for a 
targeting item are the same in a multisite environment or an unregistered site environment. 

The following chapters in this guide contain instructions for the creation and basic configuration of these 
items: 

 User Segments 

 Content Groups 

 Content Targeters 

This section adds to those instructions by explaining how to configure and use the multisite rule 
extensions for these items. 

If you work in an unregistered site environment, you do not need the information in this section. 

If you work in a multisite environment, read this section before you start to configure a user segment, 
content group, or targeter. The decisions that you make regarding the multisite rules affect your choices 
for the remaining configuration options. 

The following approach is recommended for planning and configuring multisite targeting: 

1. Determine the goals for the site. 

2. Plan a strategy for achieving the goals: What actions must occur on each site? 

3. Decide what targeting items are required. 

4. Plan the interaction of the targeting item rules. 

5. Create and configure the targeting items. 

The section Examples of Multisite Rule Use shows two basic examples of using multisite rules. 
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When Multisite Rules Are Evaluated 

The multisite rules are evaluated when the site visitor requests a page that involves a targeter. (See How 
Targeters Work with Site Displays.) These rules include the targeter’s rules and the rules for the user 
segments and content groups that are referenced by the targeter. The rules are evaluated in the context 
of the current production site (where the site visitor is). This evaluation determines which rules to execute. 

Multisite Rule Types 

Instead of one rule or rule set per targeting item, which is standard in an unregistered site environment, a 
multisite environment supports one default rule and zero or more site override rules per targeting item. 

Default Rules 

Each user segment or content group has one default rule. A targeter has one default rule set group. 

The default rule is required; it cannot be deleted. The default rule executes on the current site (where the 
site visitor is), unless a site override rule specifies that site for its own execution. If one or more site 
override rules, collectively, specify all the sites, the default rule will never be executed. However, the 
default rule exists for the standard case, as well as for the exceptional one. 

Site Override Rules 

Each user segment or content group can have zero or more site override rules; a targeter can have zero or 
more override rule set groups. 

Each site override rule specifies one or more sites on which to execute. This enables you to specify 
different behavior on different sites. 

Site override rules must meet the following requirements: 

 A site override rule must specify at least one execution site. 

 Two site override rules for the same targeting item (user segment, content group, or 
targeter) cannot specify the same execution site. 

The Rules Tab 

In the editing pane of a personalization asset, the Rules tab displays and manages multiple multisite rules. 
The Save and Revert actions apply to all the rules on the page. 

The Default Rule or Rule Set appears at the top of the Rules pane, under the title Default Rule. 

One or more Site Override Rules or Rule Sets appear below the Default Rule. When you add site override 
rules, the system generates sequential, numeric names: 

Site Override Rule 1 

Site Override Rule 2 

Site Override Rule 3 
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Making Site Selections 

When you create a multisite override rule for a user segment, content group, or targeter, you can use the 
Executes On selection to specify one or more sites on which the rule executes. When you configure a 
content group or a targeter, you can also specify on what site to look for content—the As Seen On 
selection.. 

Site selector selection lists for multisite rules include all registered sites, regardless of state—which may 
be one of the following: 

 Enabled; normally, this means available to external and internal users 

 Enabled: pre-launch 

 Enabled: post-closed 

 Disabled; normally, this means available only to internal users 

As Seen On 

On the rules for a content group or a targeter, you use the As Seen On site filter to specify one or more sites 
on which to search for content. If you do not make any selection, the default is to search only the current 
production site. 

To enable the As Seen On site filter, you must make certain Content Source and Content Type selections 
before you click the Rules tab when you create a content group or a targeter. Select a Content Source that 
is a multisite repository item with site membership, and a Content Type that has site membership. Out of 
the box, the selections that qualify are: 

 Content Source: ProductCatalog  

 Content Type: Category, Product, or SKU 

 

Content Source and Content Type selections on the General tab 

To use the As Seen On site filter: 

1. Click the As Seen on button at the right of the rule header. 
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The site selector dialog opens. 

2. Click the As Seen On selection box. The As Seen On dialog box appears. 

3. Click Current Site to see the menu. 

 

The choices are: 

 Current Site 

Current Site is the default when you select As Seen On and do not choose 
another site. It is also the default behavior when you do not use the site filter 
(you do not choose As Seen On). 

 Any Site 

 These Site(s) 

Click the new box that opens to see a list of sites. Check the checkbox next to 
one or more choices and click OK. 

 Sites Sharing Shareable 

Click the arrow between Sites Sharing Shareable and With Current Site to see 
the shareable selections. To make a selection, highlight your choice. 

 

Click With Current Site to see the alternate choice: With Site. 
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If you select With Site, another box appears. Click the arrow in the (choose a 
site) box to see a list of sites. Select your choice by highlighting it. 

The list of potential sites includes all registered sites, regardless of their operating 
states, as described above in Making Site Selections. 

4. Finish the rest of the rule configuration. 

5. Click Create. 

When a targeter references one or more content groups and the rules for both items use site filters, the As 
Seen On site filters must not explicitly conflict. Avoid a configuration such as the one in the following 
table: 

 

Content group configuration Targeter configuration 

Override rule to execute on Site D: 

As Seen On Site C CONFLICT 
 

Override rule to execute on Site D: 

As Seen On Sites A and B  

 

Executes On 

To specify the site on which the rule should execute: 

1. Click the Add Override Rule or Add Rule Set button. 

The override rule or rule set opens. 

 

2. Click the Executes On text box. 

A list of execution sites appears. Use the check box to select the intended site, then 
click OK. 

The list of potential execution sites includes all registered sites, regardless of their 
operating states, as described above in Making Site Selections. 

3. Finish the rest of the rule configuration. 

4. Click Create. 

Reusing Content Group Rules from an Unregistered Site Environment 

A content group rule that ran in an unregistered site environment will run in a multisite environment. 
Without reconfiguration, the rule will execute on and include content from only the current site. 
Therefore, if the previous collection of content items is not associated with that site, results from the 
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complete collection will not be included. Using multisite rules, you can reconfigure the content group to 
include items on all sites, or to refine the selection. 

Examples of Multisite Rule Use 

Multisite rules provide different ways to achieve targeting goals. This section describes two configurations 
to illustrate basic multisite rule interactions. 

Example 1: LatestGear Sports 

LatestGear Sports maintains three sites that sell specialty sporting gear: 

 Site A: LatestGear - Golfing 

 Site B: LatestGear - Kayaking 

 Site C: LatestGear - Skiing 

LatestGear Sports wants shoppers who live in selected states in the U.S.A. to see gear for sports that are 
popular in those states, no matter what site these shoppers visit. The display of these items depends upon 
the site of the current visit and the shopper’s address. 

The configuration for this example includes one user segment, one content group, and two targeters. The 
definition of the user segment and the content of the content group are dynamic; both depend on the 
execution site. When the rules for these items are configured as shown below, this is the result: 

 On site A, all shoppers see all the golfing items on site A. Shoppers who live in Maine, 
New Hampshire, or Vermont also see kayaking and skiing items from sites B and C, as 
defined by the content group SelectedGear. 

 On site B, all shoppers see all the kayaking items on site B. Shoppers who live in Florida 
or California also see golfing items from site A, as defined by the content group 
SelectedGear. 

 On site C, all shoppers see all the skiing items on site C. Shoppers who live in Florida or 
California also see golfing items from site A, as defined by the content group 
SelectedGear. 

The configuration for Example 1 includes: 

 User segment: SpecialAddresses; the definition depends on the execution site. 

Default Rule: Include people whose home address is in Maine or New Hampshire or 
Vermont. This rule executes only on site A, because a site override rule exists for sites B 
and C. 

Site Override Rule 1: Include people whose home address is in California or Florida. 
This rule executes on Sites B and C. 
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Rules for user segment SpecialAddresses 

 Content group: SelectedGear; the definition depends on the execution site. 

Default Rule: Include skiing and kayaking items from sites B and C catalog folders. This 
rule executes only on site A, because a site override rule exists for sites B and C. 

Site Override Rule 1: Include golfing items from site A catalog folders. This rule 
executes on sites B and C. 
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Rules for content group SelectedGear 

 Targeter: ShowAllGear 

Default rule: Show All Items to Everyone Always. This rule executes on any current site 
(A, B, or C), because no override rules exist. The unused site filter (As Seen On) defaults 
to Current Site. 
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Default rule set for targeter ShowAllGear 

 Targeter: ShowSelectedGear 

Default Rule Set: Show items in group SelectedGear to people in group 
SpecialAddresses. This rule executes on any current site (A, B, or C), because no 
override rules exist. However, the behavior is not the same on all sites, because the 
items in the content group SelectedGear and the members of SpecialAddresses are 
site-dependent. The As Seen On site specifications in the content group Selected Gear 
override the As Seen On default value in the targeter, which is Current Site. 

 

Default rule set for targeter ShowSelectedGear 
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Example 2: LatestWear Women’s and Men’s Apparel 

LatestWear Women’s and Men’s Apparel supports two sites: 

 Site A: TrendyDiscounts 

 Site B: ExecutiveTrends 

LatestWear wants younger shoppers to see only items that are styled to appeal to a younger age group. 
Each site has a different age range that qualifies as “young.” 

The configuration for this example includes one user segment, one content group, and two targeters. The 
definition of the user segment and the content of the content group are dynamic; both depend on the 
execution site. When the rules for these items are configured as shown below, this is the result: 

 On site A, shoppers whose ages are 20-30 see only targeted items from site A. 
Shoppers whose age is not in the range 20-30 see all items on site A. 

 On site B, shoppers whose age is 25-40 see only targeted items from site B. Shoppers 
whose age is not in the range 25-40 see all items on site B. 

The configuration for Example 2 includes: 

 User segment: YoungShoppers; the definition depends on the execution site. 

Default Rule: Include People whose age is 20-30. This rule executes only on site A, 
because an override rule exists for site B. 

Override Rule 1: Include People whose age is 25-40. This rule executes on site B. 

 

Default rule for user segment YoungShoppers 

 Content group: YoungWear; the content depends on the execution site. 
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Default Rule: Include items As Seen On Current Site whose Default description 
contains “young.” This rule executes on site A or B, because no override rule exists. 

 

Default rule for content group YoungWear 

 Targeter: ShowStandard 

Default Rule Set: Show all items to people not in group YoungShoppers. 
This rule executes on site A or B, because no override rule exists. 

 

Default rule set for targeter ShowStandard 

 Targeter: ShowYoungWear 
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Default rule: Show items in content group YoungWear to people in user segment 
YoungShoppers. This rule executes on site A or B because no override rule exists. The 
items in YoungWear and the members of YoungShoppers are site-dependent. 

 

Default rule set for targeter ShowYoungWear 
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4 User Segments 

A user segment represents a group of people in your target audience. You create segments by defining 
rules that include or exclude users according to their profile properties. For example, you could create a 
segment called High Earners that includes female college graduates earning more than $150,000 per year 
but excludes people from California. The rules that define this segment might look something like this: 

Include these people: 

   people whose Gender is Female 

   and whose educationLevel is College Graduate 

   and whose annualIncome is greater than 150000.00 

--------------------------------------------------- 

Exclude these people: 

   people whose Home address's State is California 

Once you set up this segment, you can use the Targeters window to create targeting rules for delivering 
personalized content to people who match the High Earners criteria. For example: 

Show this content: 

   newLuxuryCars 

To these people: 

   people in group HighEarners 

As you can see, segmenting your target audiences can simplify your targeting rules and make them easier 
to maintain. 

Creating a User Segment 
Whenever you create a user segment, the system assigns a new property with the same name as the 
segment to every profile of that type in the repository. It sets that property to “true” or “false” according to 
whether the profile meets the criteria for that segment. For example, if you create a segment called High 
Earners for profiles of type Investor, the system gives every Investor profile a new property called 
HighEarners. If a profile fits the criteria for that segment, the system sets the HighEarners property in 
that profile to “true.” If a profile does not fit the segment criteria, the HighEarners property is set to 
“false.” The system uses this method to determine which profiles belong to each user segment. 

To create a segment: 

1. From the BCC Home page, select Personalization > Targeting and Segmentation. 
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2. Specify a name and an optional description for the project that will manage the 

creation and versioning of the new segment. 

3. Select User Segments from the Show list. 

4. Click the Create New… icon and select Create New > Segment. 

 

5. Complete the fields in the General tab as follows. 

Name: Enter a name for the new segment. The name can include spaces. 

Description: Enter some descriptive text to help identify the new segment. 

Profile Type: Select the profile type that corresponds to the users you want to belong 
to the segment (assuming they meet the additional criteria you define). The options 
that appear are the item descriptor types in the profile definition file being used by 
your system, including any sub-types of those items. 

The example shown in the previous section assumes your profile definition includes a 
base type, User, with two sub-types, Investor and Broker. Using the example, if you 
wanted all site visitors to be able to qualify for a segment called New Members, you 
would specify the base type of profile, User. For a segment called High Earners that 
you knew would apply exclusively to visitors who were investors, you could specify the 
sub-type Investor as the profile type for that segment. By constraining the potential 
membership of a segment to a specific sub-type of profile, you can minimize the 
number of profiles that the system must change as a result of creating the segment. 

Note that you cannot edit the profile type after you have clicked the Create button to 
create the segment. Switching to the Rules tab also makes these settings permanent 
for this segment. 

6. By default, segments are stored as files with the extension .properties in 
/atg/registry/RepositoryGroups. To change the folder in which the new 
segment is stored, click Select Parent and specify the new folder. 

Note: If you need to change the location after the segment has been created, use the 
Move icon. 

7. When you have completed the fields in the General tab, click Create. The new segment 
is added to the project as an asset. 
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8. Click Rules to display the Rules tab, and then follow the procedure in the next section, 

Defining User Segment Rules. 

Defining User Segment Rules 
As part of the process of creating a segment, you need to set up the rules that define the user profiles that 
will be included in the group. 

Note: The configuration for the basic definition of the users in a user segment is the same in an 
unregistered site or a multisite environment However, in a multisite environment, the user interface 
displays extensions to the rule configuration. For information about how to use the rule extensions in a 
multisite environment, see Multisite Targeting Rules. 

To define the users in a user segment: 

1. Display the Rules tab for the user segment. 

2. Click Include or Exclude in the Rules title bar. 

 Use Include to define the segment by the profiles you want to include. 

 Use Exclude to define the segment by the profiles you want to exclude. 

The beginning of the new rule appears in the Rules panel: 

 

3. Specify the profiles you want to include or exclude. To do so, click the default choice, 
Everyone. The following options appear: 

 

 Select Everyone if you want to include or exclude all profiles stored in the 
profile repository. 
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 Select People whose… if you want to include or exclude users based on 

specific properties in the profile repository used by your environment. When 
you select this option, several fields appear, allowing you to select the property, 
comparison operator, and value you want to use. 

 

The selections in the Comparison Operator and Value drop-down lists change 
depending on the property you select. If the property has a limited set of 
values, the Value list includes all of your possible choices. If the property has an 
unlimited number of values, you can type a unique value directly into the list as 
shown below. An instruction showing the value type required appears below 
the text field. 

 

You can further qualify this condition with more criteria, for example: 

People whose email address contains atg.com and telephone 

number starts with 617. 

To do so, click the second bracket and select “or” or “and,” as shown: 

 

You can then enter additional criteria. Note the difference between adding 
more criteria here and adding them by clicking the diamond at the end of the 
phrase. If you add another “and” condition by clicking the diamond, you create 
an expression that represents the union of two sets: 
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People whose email address contains atg.com and people whose 
telephone number starts with 617. 

 Click People in Group(s) if you want to include or exclude profiles from an 
existing segment. Then select the segment you want to add. Note that the 
segment must have a base version in the versioning system to appear as an 
option (in other words, it must have been created in another project and 
approved for deployment). 

If multiple segments exist and you want to specify more than one, click the 
bracket symbol after the first segment you entered, and select the comma 
option: 

 

You can then specify another group. Repeat as many times as needed. 

You can also add other criteria to further qualify this statement (for example, 
People in Group Brokers whose Registration Date is Before 

June 1, 2004. To do so, click the element at the end of the phrase, as shown, 
and select Whose: 

 

Follow the instructions for the People Whose… option above. 

 Select People Common to Groups to specify any profiles that appear in 
multiple segments; enter the segments to use as the criteria. Again, click the 
bracket and select the comma option to enter multiple segments. 

 Select People with Role(s) if you want to include or exclude users who have 
been assigned specific global or organizational roles. When you click the role 
field, the Select dialog appears, which you can use to choose the roles you 
want. See Using the Asset Picker to Select Items for more information. 

You can add other criteria to further qualify this statement. To do so, click the 
diamond at the end of the phrase and select Whose. Follow the instructions for 
the People Whose… option above. 
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4. If you want to add other condition statements to the rule, click the period at the end of 

the expression and select “And” or “Or.” 

5. When you have finished defining the rule, click Save (or Create). 

6. Follow the steps outlined in Project Basics to mark the Author task as complete and 
advance the project to the next task, usually Approval. When all tasks are complete, 
the project can be deployed, and the new segment will be available on the live site. 

Deleting User Segments 
To delete a user segment, select the checkbox for the segment and click the Delete icon. If you delete a 
folder containing a segment, and the following error message occurs, refer to Deleting Segment or 
Content Group Folders for information. 

Error: Cannot delete the folder because it has contents which may not be displayed 

in the current view. 
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5 Content Groups 

The Content Groups window lets you create and define content groups—collections of content items 
that share common properties—for easier targeting. For example, you could create a content group 
called NewNYInfo that includes special content items for new site members who live in New York. The 
rules that define this group might look like this: 

Include this content: 

   items whose TargetAudience is NewUsers 

   and whose keywords includes New York 

You can then use the Content Targeters window to set up the business rules for delivering this content to 
its intended audience. For example: 

Show this content: 

   items in group NewNYInfo 

to these people: 

   people whose Registration date is after 03/31/2004 

Whenever you create a content group, the system assigns a new property with the same name as the 
content group to every content item in the repository. It sets that property to “true” or “false” according to 
whether the content item matches the group definition. For example, if you create a content group called 
NewNYInfo, the system gives every content item a new property called NewNYInfo. If an item fits the 
criteria for that group, the system sets the NewNYInfo property for that content to “true.” If an item does 
not fit the group criteria, the NewNYInfo property is set to “false.” The system uses this method to 
determine which items belong to each group. 

Creating a Content Group 
Follow the procedures in this section to create a content group. 

1. From the BCC Home page, select Personalization > Targeting and Segmentation. 

2. Specify a name and an optional description for the project that will manage the 
creation and versioning of the new content group. 

3. Select Content Groups from the Show list. 

4. Click the Create New… icon and select Create New > Content Group. SHOT IS OK 
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5. Complete the fields in the General tab as follows. 

Name: Enter a name for the new group. The name can include spaces. 

Description: Enter some descriptive text to help identify the new group. 

Content Source: Select a repository from the Content Source drop-down list. The 
repository you select determines the content items, content type, and content 
properties that you can select for inclusion in this group when you define its rules (see 
the next section). The group can include only items in this repository. 

Content Type: Select the type of content you want to be able to include. The type 
corresponds to the subset of items defined for the item descriptor type in the content 
repository definition file. Each item type has its own properties. For more information, 
refer to the ATG Repository Guide. 

Note that you cannot edit these settings after you have clicked the Create button to 
create the content group. Switching to the Rules tab also makes these settings 
permanent for this content group. 

6. By default, content groups are stored as files with the extension .properties in 
/atg/registry/RepositoryGroups. To change the folder where the new segment 
is stored, click Select Parent and specify the new folder. 

Note: If you need to change the location after the content group has been created, 
use the Move icon. 

7. When you have completed the fields in the General tab, click Create. The new content 
group appears in the Browse tab, and it is added to the project as an asset. 

8. Click Rules to display the Rules tab, and then follow the procedure in the next section, 
Defining Content Group Rules. 

Note that it is possible to continue to the Rules tab without clicking the Create button 
first; however, doing so means that the changes you have made so far are not saved, 
and the content group will be lost if your session ends or if you navigate to a different 
part of the UI. If you select Create, the new group is preserved, and you can continue 
the process of defining it at any time. 
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Defining Content Group Rules 

Each time you add a new content group, you need to set up the rules that define the content that will be 
included in the group. 

Note: The configuration for the basic definition of the contents in a content group is the same in an 
unregistered site or a multisite environment. However, in a multisite environment, multisite rule 
extensions are displayed. For information about how to use the rule extensions in a multisite 
environment, see Multisite Targeting Rules. 

To define the content in a content group: 

1. Display the Rules tab for the content group 

2. Click Include or Exclude in the Rules title bar. 

 Use Include to define the content group by the content you want to include. 

 Use Exclude to define the content group by the content you want to exclude. 

The beginning of the new rule appears in the Rules panel: 

 

3. Specify the content you want to include or exclude. To do so, click the default choice, 
All Items. The following options appear: 

 

4. Specify the content you want to show or hide: 

 Click All Items if you want to include or exclude all content items stored in the 
selected repository. 

 Click Items in Group(s) if you want to include or exclude items from other 
existing content groups. Then select the group you want to add. Bear in mind 
that the only groups that can appear as options are those whose content source 
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and type match the content source and type you specified in the General tab 
for this group. Note also that a content group must have a base version in the 
versioning system for it to appear here, which means it must have been added 
to another project and checked in (but not necessarily deployed). For more 
information on how and when an asset is checked in, refer to the ATG Content 
Administration Guide for Business Users. 

If multiple groups exist and you want to specify more than one, click the 
bracket symbol after the first group you entered, and select the comma option: 

 

You can then specify another group. Repeat as many times as needed. 

You can also add other criteria to further qualify this statement (for example, 
Items in Group News whose Last Modified Date is after June 3, 

2006.). To do so, click the diamond at the end of the phrase, as shown, and 
select Whose: 

 

Follow the instructions for the Items Whose… option below. 

 Click Items Common to Groups to specify any items that appear in multiple 
groups; enter the groups to use as the criteria. Again, click the bracket and 
select the comma option to enter multiple groups. 

 Click Items in Folder(s) if you want to include or exclude all items from specific 
repository folders. The asset picker appears; use it to specify the folders you 
want. For more information, see Using the Asset Picker to Select Items. 

As before, you can add other criteria to further qualify this statement by clicking 
the period at the end of the phrase and selecting Whose… 

Follow the instructions for the Items Whose… option below. 

 Click These Item(s) if you want to include or exclude specific content items. Use 
the asset picker to select the individual content items you want to specify. 
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You can define additional criteria by selecting the Whose option. 

 Click Items Whose… if you want to include or exclude items based on specific 
content properties. When you select this option, several fields appear, allowing 
you to select the property, comparison operator, and value you want to use. 

 

The properties that are available for selection depend on the repository you are 
working with. The selections in the Comparison Operator and Value drop-down 
lists change depending on the property you select. If the property has a limited 
set of values, the Value list will include all of your possible choices. If the 
property has an unlimited number of values, you can type a unique value 
directly into the list as shown below. An instruction showing the value type 
required appears below the text field. 

 

5. If you want to add other condition statements to the rule, click the element at the end 
of the expression and select “and” or “or.” 

6. If you want to make the group definition even more specific, click Include or Exclude 
again to create a rule set within the definition, and then repeat the steps above. 

7. Click Create when you have finished defining the rule. 

8. Follow the steps outlined in Project Basics to mark the Author task as complete and 
advance the project to the next task, usually Approval. When all tasks are complete, 
the project can be deployed, and the new targeter will be available on the live site. 

Deleting Content Groups 
To delete a content group, select the checkbox for the group and click the Delete icon. If you delete a 
folder containing a content group, and the following error message occurs, refer to Deleting Segment or 
Content Group Folders for information. 
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Error: Cannot delete the folder because it has contents which may not be displayed 

in the current view. 
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6 Content Targeters 

After you set up user segments and content groups, you tell the system which content groups to show to 
whom and under which circumstances. You can do this is by setting up content targeters, which are 
business rules that you create through the Targeting and Segmentation option in the ATG Business 
Control Center. Content targeters define the content that you display to each user segment. 

A content targeter can contain two kinds of business rules: show and hide. Each rule type is made up of 
specific conditions related to content, people, time, and environmental factors and generally reads as 
follows: Show/Hide this content… to/from these people… at these times… under these conditions. For 
example, suppose you wanted to show new feature articles (in a content group called 
newMemberFeatures) to registered site users (in a user segment called registeredMembers) every 
Monday. In this case, you could create a targeter called newFeatures with the following rule: 

Show this content: 

   items in group newMemberFeatures 

to these people: 

   people in group registeredMembers 

at these times: 

   every Monday of every month 

When this targeter is invoked, it initially looks at all conditions except the content conditions. First, it 
checks to see if the registeredMembers property in the user’s profile is set to “true” (the people 
condition). If this or any other condition fails, the targeter completely ignores the rule. If the condition 
passes, it goes on to see if the current day is Monday (the time condition). If all of these conditions pass, 
the targeter looks at the content condition to determine the items to show or hide. In this case, it shows 
the user all items in the newMemberFeatures content group. 

After you create a targeter, a page developer uses a targeting servlet bean to embed it in the appropriate 
site pages so that it will display the specified content to visitors who meet your targeting conditions. 
(Typically, page developers use the Document Editor window in the ATG Control Center to embed 
targeters in JHTML or JSP (JavaServer Page) files. For more information, see the ATG Page Developer’s 
Guide.) 

Note: Multiple targeters can be used to produce a single Web page. For example, nine separate targeters 
are invoked to produce the “investor” home page (investorhome.jsp) in the Quincy Funds demo. 

Using Scenarios to Match Content to Users 

If you use the Scenarios module, you can match content to user segments in two ways: you can either 
create targeters (as described above), or you can use scenarios to achieve essentially the same results. The 
method you choose depends on whether you require the advanced features that scenarios provide, or 
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whether the slightly simpler features of targeters meet your requirements. You can also set up a 
combination of the two methods. Note, however, that you create scenarios through the ACC, not through 
the ATG Business Control Center. For more information, see the ATG Personalization Guide for Business 
Users. 

Creating Targeters 
This section describes how to create a content targeter that you can use to display appropriate content to 
specific users. 

1. From the BCC Home page, select Personalization > Targeting and Segmentation. 

2. Specify a name and an optional description for the project that will manage the 
creation and versioning of the new targeter. 

3. Select Targeters from the Show list. 

4. Click the Create New… icon and select Create New > Targeter. 

 

5. Complete the fields in the General tab as follows. 

Name: Enter a name for the new targeter. The name can include spaces. 

Description: Enter some descriptive text to help identify the new targeter. 

Content Source: Select a repository from the Content Source drop-down list. The 
repository you select determines the content items, content type, and content 
properties you can target against. The targeter will apply only to items in this 
repository. 

Content Type: Select the type of content you want to target against. The type 
corresponds to the subset of items defined for the item descriptor type in the content 
repository definition file. Each item type has its own properties. For more information, 
refer to the ATG Repository Guide. 
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Profile Type: Select the type of users to whom this targeter can apply. The options 
that appear are the item descriptor types in the profile definition file being used by 
your system, including any sub-types of those items. 

Note that you cannot edit these settings after you have clicked the Create button to 
create the targeter. Switching to the Rules tab also makes these settings permanent 
for this targeter. 

6. By default, targeters are stored as files with the extension .properties in 
/atg/registry/RepositoryTargeters. To change the folder where the new 
targeter is stored, click Select Parent and specify the new folder. 

Note: If you need to change the location after the targeter has been created, use the 
Move icon. 

7. When you have completed the fields in the General tab, click Create. The new targeter 
appears in the Browse tab, and it is added to the project as an asset. 

8. Click Rules to display the Rules tab, and then follow the procedure in the next section, 
Defining Targeter Rules. 

Note that it is possible to continue to the Rules tab without clicking the Create button 
first; however, doing so means that the changes you have made so far are not saved, 
and the targeter will be lost if your session ends or if you navigate to a different part of 
the UI. If you select Create, the new targeter is preserved, and you can continue the 
process of defining it at any time. 

Defining Targeter Rules 
Each time you add a new content targeter, you need to set up the business rules for delivering the 
selected content to its target audience. For example, you could create a rule that shows content from a 
folder called Weekend Features to all users every Friday. 

A word about targeters and site performance: The ATG Personalization module caches (or temporarily 
stores) the content that it displays after each targeting operation. This behavior allows it to serve the 
content much faster to the next visitor who matches the targeting criteria. This caching mechanism will 
not be effective if your targeting rules include profile or request properties (time of day, for example) that 
have many possible values for each visitor. For example, if you create a targeter that includes a multi-
value property called interests, and there are many possible value combinations for each visitor 
(“skiing, golf, hockey,” “biking, golf,” “soccer, tennis, swimming,”), it is unlikely that the Personalization 
module would be able to use the page results cached from previous requests, and the targeting 
operation would take longer. 

Note: The configuration for the basic definition of the targeter is the same in an unregistered site or a 
multisite environment However, in a multisite environment, multisite rule extensions are displayed. For 
information about how to use the rule extensions in a multisite environment, see Multisite Targeting 
Rules. 

To set up or edit the business rules for a content targeter: 

1. Display the Rules tab for the targeter. 
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2. Click Show or Hide at the top of the Rule Set panel. 

 Show lets you specify the content you want visitors to see. 

 Hide lets you lets you specify the content you don’t want visitors to see. 

Note: Show rules are evaluated before hide rules. 

A rule with default values appears in the Rule Set panel. For example, if you click Show, 
you see the following fields: 

 

3. Use these shown to set the rule’s content, people, time, and environment conditions. 
See the following sections for the procedures: 

 Setting Content Conditions 

 Setting People Conditions 

 Setting Date and Time Conditions 

 Setting Environment Conditions 

4. To add another “Show” section to the same rule, click the Show button and complete 
the form. 

5. To add another rule set, select Add Rule Set (not shown in the image above), and 
repeat steps 2-4. For more information on creating multiple rule sets, see the Creating 
and Prioritizing Multiple Rule Sets section. 

6. When you have finished setting up your targeting rules, click Save (or Create). 

7. Follow the steps outlined in Project Basics to mark the Author task as complete and 
advance the project to the next task, usually Approval. When all tasks are complete, 
the project can be deployed, and the new targeter will be available on the live site. 

For information on embedding the targeter in the appropriate site pages, see the ATG Page Developer’s 
Guide. 
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Setting Content Conditions 

Content conditions are used to find content items that match some sort of criteria. For example: 

Show this content: 

   items whose keywords includes Hiking 

You can combine multiple content conditions by using AND statements and OR statements. 

If your product suite includes ATG Commerce, the content you can show includes any promotions you 
have set up. For more information, on promotions, refer to the ATG Commerce documentation. 

To set a rule’s content conditions: 

1. Click in the This Content field in the Rule Set panel. The following options appear: 

 

2. Specify the content you want to show or hide: 

 Click All Items if you want to show (or hide) all content items stored in the 
selected repository. 

 Click Items in Group(s) if you want to show or hide items from specific content 
groups created in the Content Groups window. Then select the group you want 
to add. Bear in mind that the only groups that appear as options are those 
whose content source and type match the content source and type you 
specified in the General tab for this targeter. 

If multiple groups exist and you want to specify more than one, click the 
bracket symbol after the first group you enter and select the comma option: 

 

You can then specify another group. Repeat as many times as needed. 

You can also add other criteria to further qualify this statement (for example, 
Items in Group Book Reviews whose Author is Smith). To do so, click 
the period at the end of the phrase, as shown, and select Whose: 
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Follow the instructions for the Items Whose… option below. 

 Click Items Common to Groups to specify any items that appear in multiple 
groups; enter the groups to use as the criteria. Again, click the bracket and 
select the comma option to enter multiple groups. 

 Click Items in Folder(s) if you want to show or hide all items from specific 
repository folders. The asset picker appears; use it to specify the folders you 
want. For more information, see Using the Asset Picker to Select Items. 

As before, you can add other criteria to further qualify this statement by clicking 
the period at the end of the phrase and selecting Whose… 

Follow the instructions for the Items Whose… option below. 

 Click These Item(s) if you want to show or hide specific content items. Use the 
asset picker to select the individual content items you want to include. 

You can define additional criteria by selecting the Whose option (described 
below). 

 Click Items Whose… if you want to show or hide items based on specific 
content properties. When you select this option, several fields appear, allowing 
you to select the property, comparison operator, and value you want to use. 

 

The properties that are available for selection depend on the repository you are 
working with. The selections in the Comparison Operator and Value drop-down 
lists change depending on the property you select. If the property has a limited 
set of values, the Value list will include all of your possible choices. If the 
property has an unlimited number of values, you can type a unique value 
directly into the list as shown below. An instruction showing the value type 
required (“Type a string,” for example) appears below the text field. 
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In addition to any preset content property values, or any values you might type 
yourself, you can also use the value list to specify the environment options 
described in the following table. To display these, click the diamond icon, as 
shown: 

 

You can use these options to set the value of your selected content property by 
testing it against a particular environment condition. 

 

Browser’s Select Browser’s to add a browser-related property to the definition. For example, 
…items whose absolutePath is Browser’s request.remoteHost. 

Locale’s Select Locale’s to add a locale-related property. For example, …items whose language 
is Locale’s acceptLanguage. 

Note: Locale properties are relevant if you are working on a localized Web site that 
displays content in different languages depending on the language setting in a 
visitor’s browser. For more information about internationalization and localization, see 
the ATG Programming Guide. 

Profile’s Select Profile’s to add another user-related property. For example, …items whose 
keywords includes Person’s Actual Investment Goal. 

Request’s Select Request’s to add a property related to the HTTP request. For example, …items 
whose relativePath is Request’s requestURI. 

Today’s Select Today’s to add a time-related property. For example, …items whose lastModified 
is Today’s date. 

 

The application developers working on your Web site can add other options to 
this list by setting up a TargetingSourceMap service in the Personalization 
module. For more information, see Setting Up Targeting Services in the ATG 
Personalization Programming Guide. 

When you select one of these options, the ATG Business Control Center displays 
another field that contains a drop-down list, prompting you to select a related 
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property. The properties that are available depend on the option you select 
from the Value list. 

3. If you want to add other content conditions, click the period at the end of the phrase, 
as shown, and then select “And” or “Or” as appropriate: 

 

4. Next, you need to specify your target audience. See the following section, Setting 
People Conditions, for details. 

Setting People Conditions 

People conditions are tested against user profile properties to see if the rule should be applied. For 
example: 

Show this content: 

   items in group NewNYinfo 

to these people: 

   people whose Registration date is after 03/31/2004 

You can combine multiple people conditions by using AND statements and OR statements. 

To set a rule’s people conditions: 

1. Click in the To These People field in the Rule Set panel. The following options appear: 

 

2. Specify the people you want to include in (or exclude from) your target audience: 

 Click Everyone if you want to include (or exclude) all users. 

 Click People in Group(s) if you want to include or exclude people from specific 
user segments. Then select Choose a Group to display a list of the user 
segments in your system. 

If multiple segments exist, and you want to specify more than one, click the 
bracket symbol after the first segment you enter and select the comma option: 
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You can then specify another segment. Repeat as many times as needed. 

You can also add other criteria to further qualify this statement (for example, 
People in Group Members whose Registration Date is before Jan 

1, 2000). To do so, click the period at the end of the phrase, as shown, and 
select Whose: 

 

Then follow the instructions for People Whose… below. 

 Click People Common to Groups to specify any users who qualify for multiple 
segments; enter the segments to use as the criteria. Again, click the bracket and 
select the comma option to enter multiple segments. 

You can also add other criteria to further qualify this statement. To do so, click 
the period at the end of the phrase, as shown above, and select Whose. 

Note: The criteria after Whose… in this case qualify the people, not the 
segments, for example People Common to Groups New Members and 
West Coast Users whose Date of Birth is Today. 

 Click People Whose… if you want to include or exclude people based on 
specific profile properties. When you select this option, several fields appear as 
shown below, allowing you to select the profile property, comparison operator 
and value you want to use to define the group. 

 

The properties that are available for selection are drawn from the profile 
repository created for your ATG environment. (For more information, refer to 
Setting Up a Profile Repository in the ATG Personalization Programming Guide.) 
The selections in the Comparison Operator and Value fields change depending 
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on the profile property you select. If the property has a limited set of values, the 
Value list will include all of your possible choices. If the property has an 
unlimited number of values, you can type a unique value directly into the field. 
An instruction showing the value type required (“Type a string,” for example) 
appears below the text field, as shown below: 

 

3. If you want to add other people conditions, click the period at the end of the phrase, 
as shown, and then select “And” or “Or” as appropriate: 

 

Next you set the time conditions for displaying the content. See the following section, Setting Date and 
Time Conditions, for details. 

Setting Date and Time Conditions 

Date and time conditions are tested against the current time to see if the rule should be applied. For 
example: 

Show this content: 

   items in group newMemberFeatures 

To these people: 

   people in group NewMembers 

At these times: 

   every Mon, Wed, Fri between 9:00am and 9:00pm 

   between 01-Jan-2007, 12:00am and 31-Jan-2007,11:59pm 

To set a rule’s date and time conditions: 

1. Click in the At These Times field in the Rule Set panel. The following options appear: 
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2. Set the time conditions you want to use. 

 Click Always to display the content whenever the user displays the page. 

 Click On to show or hide content on a specific date. For example, On Dec 19, 
2006. You can then choose whether the content is displayed all day or between 
specific times on that day. 

 Click Between to show or hide content between specific dates. 

 Click After to show or hide content starting on a specific date (without an end 
date). For example, after Dec 19, 2006, 12:00:00 AM. 

 Click Before to show or hide content beginning immediately up until a specific 
date. For example, before Dec 18, 2006, 11:59:00 PM. 

 Click Every to show or hide content on certain days of each month. For 
example, Every Monday of Every Month between 9 AM and 12 PM. 

 Click The First, The Second, The Third, The Fourth, or The Last to show or 
hide content on certain weekdays every month. For example, The Last 
Tuesday of Every Month between 9:00am and 11:59pm. 

 Click On These Days of the Month to show or hide content on the same dates 
each month. For example, On These Days of the Month: 5, 10, 15, 
20, 25. 

If you want to specify more than one date, click the bracket after the first date 
and select the comma option, as shown below: 

 

You can then use the field that appears to specify an additional date. Repeat as 
needed. 
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Next, you can set other environment conditions for the rule. See the following section, Setting 
Environment Conditions, for more information. 

Setting Environment Conditions 

Environment conditions cover properties that are not necessarily related to the user’s profile or the 
current time. For example, the type of Web browser a visitor is using might not be included in his or her 
profile, but that information is available when the visitor accesses the site and it can be used for targeting 
then. For example: 

Show this content: 

   items whose platform is Macintosh 

Under these conditions: 

   if Browser's using Macintosh system is true 

To set a rule’s environment conditions: 

1. Click in the Under These Conditions field in the Rule Set panel. The following options 
appear: 

 

2. Use the options as described below. 
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Browser’s Select Browser’s to set a browser-related condition. For example: Browser's 

supports cookies is true. 

Locale’s Select Locale’s to set a locale-related condition. For example, if Locale's 
defaultRequestLocale is en_ US. 

Note: Locale options are relevant if you are working on a localized Web site that 
displays content in different languages depending on the language setting in a 
visitor’s browser. For more information about internationalization and localization, 
refer to the ATG Programming Guide. 

Profile’s Select Profile’s to set a person-related condition. For example, if Profile's Home 
address's State is NY. 

Request’s Select Request’s to set an HTTP request-related condition. For example, if 
Request's loggingInfo is false. 

Developer’s Note: The ATG Business Control Center does not display form 
parameters in the drop-down list of Request properties. If you want to include form 
request parameters in your targeting business rules, you can work around this by 
creating a request-scoped Form Handler object and adding it to the 
TargetingSourceMap service in the Personalization module. (For more information 
on setting up a TargetingSourceMap service, see Setting Up Targeting Services in the 
ATG Personalization Programming Guide.) After your new Form Handler is in the 
TargetingSourceMap, all the object’s properties should appear in a drop-down list of 
Form Handler properties in the ATG Business Control Center. You can then select 
them for your targeting business rules. 

Today’s Select Today’s to set a time-related condition. For example, if Today's date is 
10/20/2006. 

 

The application developers working on your Web site can add other environment 
options to this list by setting up a TargetingSourceMap service in the Personalization 
module. For more information, see Setting Up Targeting Services in the ATG 
Personalization Programming Guide. 

When you select one of these options, the ATG Business Control Center displays 
additional fields (illustrated below), allowing you to select the property, comparison 
operator, and value you want to use. 
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The selections in the Comparison Operator and Value drop-down lists change 
depending on the property you select. If the property has a limited set of values, the 
Value list will include all your possible choices. If the property has an unlimited 
number of values, you can type a unique value directly into the field. An instruction 
showing the value type required (“Type a string,” for example) appears below the text 
field: 

 

3. If you want to add other environment conditions, click the period at the end of the 
phrase, as shown, and then select “And” or “Or” as appropriate: 

 

Creating and Prioritizing Multiple Rule Sets 
Business rules are evaluated sequentially as they appear in the Rules tab in the content targeter window. 
Inserting breaks between rules creates different sets of rules. When rules are grouped in sets, you can 
move them up or down to change the order in which they are evaluated. You can also use multiple rule 
sets to display default content in the event that certain rule conditions fail. 

For example, the following targeter includes three rule sets: 

Show this content: 

   items whose Target Audience includes Person's Strategy 

   and whose Language starts with Locale's localeString 

to these people: 

   people whose User type is investor 



A T G  B u s i n e s s  C o n t r o l  C e n t e r  U s e r ’ s  G u i d e  

7 7  

6  -  C o n t e n t  T a r g e t e r s  

μ
-------------If no items were selected, try the following rules---------- 

Show this content: 

   items whose Target Audience includes guests 

   and whose Language starts with Locale's localeString 

to these people: 

   people whose User type is guest 

-------------If no items were selected, try the following rules----------- 

Show this content: 

   items whose Target Audience includes anybody 

   and whose Language starts with Locale's localeString 

to everyone 

If the first set produces no results, the system uses the Show rule in the second set. If the second set 
produces no results either, the system uses the Show rule in the third set. 

Note: You must organize your rules into rule sets as you create the rules; you cannot break rules into sets 
later. 

To create a rule set: 

1. Click the Add Rule Set button at the bottom of the Rules tab. The following rule break 
appears at the bottom of the rule list: 

-----If no content was selected, try the following rules----- 

2. Set up the rules for the new rule set. (See Defining Targeter Rules for details.) You can 
move the rule set by clicking the Move Up or Move Down icons in the Rule Set title 
bar: 
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μ
evaluation, 40 
override, 40 
overview, 39 
planning the configuration, 39 
types, 40 

O 
organizations, searching for, 18 
override rules, 40 

P 
personalized content. See content targeters 
post-closed 

site, 41 
pre-launch 

site, 41 
preview features 

description, 29 
previewing assets, 29 
profile groups. See segments 
Project tab, 35 
projects 

adding assets, 14 
completing, 15 
creating, 13 
definition, 12 
opening existing, 17 

R 
roles 

required, to use BCC, 6 
searching for, 18 

rules 
examples of multisite, 44 
for targeters, 65 
for user segments, 53, 59 
multisite content group.  
multisite targeter, 65 
multisite types, 40 
multisite user segment, 53 
site override, 40 
tab, 40 

Rules tab, 35 

S 
scenarios 

editing, 5 
using for content targeting, 63 

Search tab, 18 
segments 

creating, 51 
default folder, 37 
defining rules, 53 
deleting, 56 

overview, 51 
Select Parent button, 37 
site 

disabled, 41 
enabled, 41 
post-closed, 41 
pre-launch, 41 

site filter, 41 
avoiding conflicts, 43 

site override rules, 40 
naming, 40 

site selection, 41 
for execution, 43 

site selector list, 41 
slots, editing, 5 
Step Edit, 21 

T 
targeters 

browser conditions, 74 
creating, 64 
date and time conditions, 72 
default folder, 37 
defining rules, 59, 65 
deleting, 35 
duplicating, 35 
grouping, 76 
locale conditions, 74 
multisite rules, 65 
overview, 33, 63 
people conditions, 70, 74 
request conditions, 74 
site performance, 65 
Today’s condition, 74 
viewing, 36 

targeting interface, 34 
Task action menu, 34 
tasks, completing, 15 

U 
user profiles, searching for, 18 
user segments. See segments 

deleting, 35 
duplicating, 35 
multisite rules, 53 
overview, 33 
viewing, 36 

V 
versioning, definition, 13 

W 
workflows, editing, 5 
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